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Maintenance Vendor Command
The purpose of these files is to provide accurate record keeping and budgeting information as to how 
much and to whom you spent money on your business trips. If you or your employer do not have the need
for such record keeping or budgeting forecasting, then each file should contain only the default "MISC" 
record and all expenses should reflect "MISC" as both the Charge-To and Vendor.

The procedures for maintenance of the Charge-To and Vendor files are identical. The information 
processed and saved is the same for both files, it's just that the files represent different things to the 
program. The Charge-To file has records containing the names and addresses of the Charge-To types 
(Payment Methods) such as "Cash", "Check", Company Credit Card", etc. While the Vendor file has 
records containing the names and addresses of the Vendors (Who You Paid) that were paid for a specific 
expense such as "American Air Lines", "Mobil Gas", "Holiday Inn", "Glenda's House of Massage", etc.

The fields for the Vendor and Charge To records are just informational and are for your own use. These 
fields, other than the record Key, are not currently used by the WXPNS system.



Maintenance Categories Command
The WXPNS system has been written to group all expenditures into ten Categories of Expenses. These 
categories are the major spending groupings that most companies want itemized and/or summarized by 
their employees when they are reporting on their business trip expenses. The initial categories that 
WXPNS creates are: Lodging, Transportation - Air or Rail, Transportation - Rental Car or Limousine, 
Transportation - Taxi/Tolls/Buses, Transportation -Automobile Expenses, Entertainment, Miscellaneous 
Expenses, Breakfast, Lunch, and Dinner.

SubCategories are useful to enter and keep track of expenses that are constant and repetitive on multiple
Expense Reports such as Mileage, Postage, and Tips.

The information that can be modified for each Category and Subcategory are the following:
* A one line description that is used throughout the program and on reports to describe this expense 

category.
* Two descriptive lines used as category report header lines on the Expense Reports.
* A minimum dollar amount to itemize field. This dollar amount must be equaled or exceeded before the

expense will be itemized on the expense report. Initially, the minimum itemized dollar amount has 
been set to $0.00 for all categories except for the three Meals which have a $25.00 amount set for 
itemizing.

* An Itemization Code that informs the program if this individual category is to be itemized on the 
Expense Report. The Itemize codes are; No itemization is needed, Detailed itemization, or one of two 
summary itemization groups.



The information required to be entered for each Sub Category is;
* a Record Key for this Sub Category,
* a numeric value to use as a multiplication constant,
* which of the ten master categories to report and total into on the Expense Report,
* and whether you want this Sub Category individually itemized or summarized on a single line on the 

Expense Report if itemization is required.

An example of a frequently used Sub Category would be "Mileage". A typical "Mileage" Sub Category 
would have "Trans-Auto Expenses" as the master category, "Mileage" as the description, "$0.31" as the 
multiply constant, and either "Yes" or "NO" as the single line summary flag.



Windows Keys
Cursor Movement Keys
Dialog Box Keys
Editing Keys
Help Keys
Menu Keys
System Keys
Text Selection Keys
Window Keys



Release Notes
No release notes yet.



Requirements
The following hardware is required:

386 or better
4MB of memory
1MB of disk space

The following software is required:

Windows 3.1 or better



Technical Features
Configuration and Data Files;

WXPNS.INI Configuration File parameters.

Corrections and Enhancements added to WXPNS versions;

Version 1.00 to Version 1.01 modifications



Introduction
WXPNS was written to automate the entry, printing and historical reporting of business travel expenses 
required by most companies. Its' purpose is to keep track of all expenses incurred by you while you were 
away on a business trip. Expenses are broken down into ten categories ranging from lodging, 
transportation, entertainment and meals just to name a few. All categories can be changed to suit your 
individual or employers needs. Sub Categories may also be created within a Category to retain 
information on repetitive expenses such as Mileage, Tolls or Postage.

Every Expense Report line item will retain fields such as the Date, Category, Vendor, Charge To, Name of
Persons Entertained, Time and Place, Nature or Purpose of the Item, Percent Allocated to Business, and 
whether the expense is reimbursable or not.

An example of a non-reimbursable expense is an airplane ticket purchased by your employer but used by 
you on the business trip. You did not pay for the ticket so you should not be reimbursed for its' cost, but 
your employer still wants the ticket itemized on your expenses for accurate record keeping and budgeting.



Toolbar
The Toolbar is a row of buttons at the top of the main window which represent application commands. 
Clicking one of the buttons is a quick alternative to choosing a command from the menu.    Buttons on the 
toolbar activate and deactivate according to the state of the application.

Button Action Menu Equivalent
Create a new Expense Report File|New

Locate and open a Expense Report File|Open

Save Expense Report with a new name File|Save As

Print the active Expense Report File|Print

Cut selected text to Clipboard Edit|Cut

Copy selected text to Clipboard Edit|Copy

Paste text from Clipboard Edit|Paste

Undo Previous edit action Edit|Undo

Maintain Category/Subcategory Info Maintenance|Categories

Maintain Vendor Information Maintenance|Vendor

Maintain Charge To Information Maintenance|Charge To

Add a blank line to Expense Report Expense Report|Add Expense Item

Duplicate current line on Expense Report Expense Report|Duplicate Expense Item

Delete current line on Expense Report Expense Report|Delete Expense Item

Display help file contents Help|Contents



File Menu
The File menu provides commands for creating new files, opening existing files, saving files, 
printing files, and exiting the application.

New Create a new Expense Report.
Open Open an existing Expense Report.
Close Close the current Expense Report.
Save As Save the current Expense Report under a new name.
Print Expense Report Print the current Expense Report.
Print Blank Expense Report Print a form with no data
Print Setup Set printer characteristics.
Exit Exit WXPNS application.

1-15 Select a valid User.



Windows Menu
The Window menu provides commands to control the position and layout of application's 
windows.

Cascade Resize and position all windows in an overlapping pattern.
Tile Resize and position all windows in an non overlapping pattern.
Arrange Icons Align all iconized windows along a grid.
Close All Close all windows.



Help Menu
The Help menu provides access to the help system and the about dialog.

Contents Help topic contents.



Exiting
To exit the application, choose File|Exit from the menu.



Printing
There are two commands on the File menu which support printing of documents from the 
application.    File|Print Setup is used to select and configure a printer device.    File|Print 
causes the current document to be printed.



File Close Command
The File|Close command closes the currently active Expense Report.



File Exit Command
The File|Exit command exits WXPNS.



File New Command
The File|New command creates a new Expense Report, and makes it the active window.

You will first be asked to enter the last date of the Expense Report. The year can be 
decreased by clicking on "<" and increased by clicking on ">". The months can be 
decreased by clicking on "-" and increased by clicking on "+". The day of the month can be 
changed by clicking on the correct number.

Next you will be shown your User Information that consists of your Name, Address, 
Department and Reimbursement flag. If any of this information needs to be changed, it 
should be modified at this time. Click on "OK" when the information is correct.

Now you will be asked to enter the Miscellaneous Expense Report Information that consists 
of the cash advance you received, the number of days spent on this trip, the amount of 
personal time you spent on the trip and the reason for the trip. Click on "OK" when the 
information is correct.

Finally, you will be asked to enter where you went and who you visited on the Daily 
Information input form. Click on "OK" when the information is correct.

After all of the above information has been entered, a new Expense Report with a single 
blank line item will be shown on the display.



File Open Command
The File|Open, or Ctrl+O, command displays the Open a File dialog box so you can select an 
existing Expense Report to load. The standard file extension for Expense Report is ".XR".



File Print Expense Report Command
The File|Print Expense Report command prints a formatted Expense Report that includes all 
the information for the current Expense Report. The program assumes the report will be 
printed in landscape mode (sideways) and will attempt to change the mode if the printer is 
set in portrait mode. A Print Options dialog box will be displayed that allows you to change 
the output printer device, print quality, copies, and other printer options.

Use File|Print Setup to select a printer, and to set printer options.



File Print Setup Command
The File|Printer Setup command displays the Printer Setup dialog box which allows you to 
select and configure the printer to be used to print documents in the application.



File Save As Command
The File|Save As command allows you to save current Expense Report under a new name, or
in a new location on disk. The command displays the Save File As dialog box. You can enter 
the new file name, including the drive and directory. If you choose an existing file name, you 
are asked if you want to overwrite the existing file. The default file extension is ".XR", which 
will be used if no file extension is given.



Windows Arrange Icons Command
The Window|Arrange Icons command arranges all iconized windows into rows along the 
bottom of the application's main window.



Windows Cascade Command
The Window|Cascade command arranges all document windows from the top-left position of 
the application's main window so that the title bar of each is visible.



Windows Close All Command
The Window|Close All command closes all document windows open in the application.



Windows Tile Command
The Window|Tile command arranges all document windows side-by-side in a non-overlapping
pattern.



Help table of contents
The Help|Contents displays the help contents page.



WXPNS 1.01
Windows Expense Reporting

Welcome to WXPNS, the friendly way to enter, keep track of and report expenses incurred during 
business trips or activities.

Overview:
Introduction
Technical Features

Product Information:
Requirements
Release Notes
Future Enhancements
Command Index

Shareware:
Shareware Definition
Registration Fee
Treeless Software and Design



Cursor Movement Keys
Key(s) Function

Arrow key Moves the cursor left, right, up, or down in a field.
End or Ctrl+Right Arrow Moves to the end of a field.
Home or Ctrl+Left Arrow Moves to the beginning of a field.
Page Up or Page Down Moves up or down in a field, one screen at a time.



Dialog Box Keys

Key(s) Function

Tab Moves from field to field (left to right and top to bottom).
Shift+Tab Moves from field to field in reverse order.
Alt+letter Moves to the option or group whose underlined letter matches 

the one you type.
Arrow key Moves from option to option within a group of options.
Enter Executes a command button.

Or, chooses the selected item in a list box and executes the 
command.

Esc Closes a dialog box without completing the command. (Same as
Cancel)

Alt+Down Arrow Opens a drop-down list box.
Alt+Up or Down Arrow Selects item in a drop-down list box.
Spacebar Cancels a selection in a list box.

Selects or clears a check box.
Ctrl+Slash Selects all the items in a list box.
Ctrl+Backslash Cancels all selections except the current selection.
Shift+ Arrow key Extends selection in a text box.
Shift+ Home Extends selection to first character in a text box.
Shift+ End Extends selection to last character in a text box



Editing Keys

Key(s) Function

Backspace Deletes the character to the left of the cursor.
Or, deletes selected text.

Delete Deletes the character to the right of the cursor.
Or, deletes selected text.



Help Keys

Key(s) Function

F1 Gets Help and displays the Help Index for the application. If the 
Help window is already open, pressing F1 displays the "Using 
Windows Help" topics.
In some Windows applications, pressing F1 displays a Help topic
on the selected command, dialog box option, or system 
message.

Shift+F1 Changes the pointer to  so you can get Help on a specific 
command, screen region, or key. You can then choose a 
command, click the screen region, or press a key or key 
combination you want to know more about.

(This feature is not available in all Windows applications.)



Menu Keys

Key(s) Function

Alt Selects the first menu on the menu bar.
Letter key Chooses the menu, or menu item, whose underlined letter 

matches the one you type, when a menu has focus.
Alt+Letter key Pulls down the menu whose underlined letter matches the one 

you type.
Left or Right Arrow Moves among menus of the main menu bar.
Up or Down Arrow Moves among menu items within a drop-down menu.
Enter Chooses the selected menu item.



System Keys

The following keys can be used from any window, regardless of the application you are 
using.

Key(s) Function

Ctrl+Esc Switches to the Task List.
Alt+Esc Switches to the next application window or minimized icon, 

including full-screen programs.
Alt+Tab Switches to the next application window, restoring applications 

that are running as icons.
Alt+PrtSc Copies the entire screen to Clipboard.
Ctrl+F4 Closes the active window.
F1 Gets Help and displays the Help Index for the application. (See 

Help Keys)



Text Selection Keys

Key(s) Function

Shift+Left or Right Arrow Selects text one character at a time to the left 
or right.

Shift+Down or Up Selects one line of text up or down.
Shift+End Selects text to the end of the line.
Shift+Home Selects text to the beginning of the line.
Shift+Page Down Selects text down one window.

Or, cancels the selection if the next window is 
already selected.

Shift+Page Up Selects text up one window.
Or, cancels the selection if the previous 
window is already selected.

Ctrl+Shift+Left or Right Arrow Selects text to the next or previous word.
Ctrl+Shift+Up or Down Arrow Selects text to the beginning (Up Arrow) or end

(Down Arrow) of the paragraph.
Ctrl+Shift+End Selects text to the end of the document.
Ctrl+Shift+Home Selects text to the beginning of the document.



Window Keys

Key(s) Function

Alt+Spacebar Opens the Control menu for an application window.
Alt+Hyphen Opens the Control menu for a document window.
Alt+F4 Closes a window.
Alt+Esc Switches to the next application window or minimized icon, 

including full-screen programs.
Alt+Tab Switches to the next application window, restoring applications 

that are running as icons.
Alt+Enter Switches a non-Windows application between running in a 

window and running full screen.
Arrow key Moves a window when you have chosen Move from the Control 

menu.
Or, changes the size of a window when you have chosen Size 
from the Control menu.



Shareware Definition
Shareware distribution gives users a chance to try software before buying it. If you try a Shareware 
program and continue using it, you are expected to register. Individual programs differ on details -- some 
request registration while others require it, some specify a maximum trial period. With registration, you get
anything from the simple right to continue using the software to an updated program with printed manual.

Copyright laws apply to both Shareware and commercial software, and the copyright holder retains all 
rights, with a few specific exceptions as stated below. Shareware authors are accomplished 
programmers, just like commercial authors, and the programs are of comparable quality. (In both cases, 
there are good programs and bad ones!) The main difference is in the method of distribution. The author 
specifically grants the right to copy and distribute the software, either to all and sundry or to a specific 
group. For example, some authors require written permission before a commercial disk vendor may copy 
their Shareware.

Shareware is a distribution method, not a type of software. You should find software that suits your needs 
and pocketbook, whether it's commercial or Shareware. The Shareware system makes fitting your needs 
easier, because you can try before you buy. And because the overhead is low, prices are low also. 
Shareware has the ultimate money-back guarantee -- if you don't use the product, you don't pay for it.

Disclaimer of Warranty

THIS SOFTWARE AND/OR MANUAL ARE SOLD "AS IS" AND WITHOUT WARRANTIES AS TO 
PERFORMANCE OF MERCHANTABILITY OR ANY OTHER WARRANTIES WHETHER EXPRESSED 
OR IMPLIED. BECAUSE* OF THE VARIOUS HARDWARE AND SOFTWARE ENVIRONMENTS INTO 
WHICH THIS PROGRAM MAY BE PUT, NO WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE
IS OFFERED. GOOD DATA PROCESSING PROCEDURE DICTATES THAT ANY PROGRAM BE 
THOROUGHLY TESTED WITH NON-CRITICAL DATA BEFORE RELYING ON IT. THE USER MUST 
ASSUME THE ENTIRE RISK OF USING THE PROGRAM. ANY LIABILITY OF THE SELLER WILL BE 
LIMITED EXCLUSIVELY TO PRODUCT REPLACEMENT OR REFUND OF PURCHASE PRICE.



Registration Fee
WXPNS is a "Shareware program" and is provided at no charge to the user for evaluation. Feel free to 
share it with your friends, but please do not give it away altered or as part of another system. The 
essence of "user-supported" software is to provide personal computer users with quality software without 
high prices, and yet to provide incentive for programmers to continue to develop new products. If you find 
this program useful and find that you are using WXPNS and continue to use WXPNS after a 10 day trial 
period, you must fill out and mail the Registration Form and make a registration payment of $35.00 (U.S. 
dollars) to Treeless Software and Design by cash, check or money order. The $35 registration fee will 
license one copy for use on any one computer at any one time.

After receipt of the registration fee, a serial number will be sent to you by return mail. The most current 
version of WXPNS will be sent to you if a shipping and handling fee is included.

Commercial users of WXPNS must register and pay for their copies of WXPNS within 10 days of first use 
or their license is withdrawn. Site-License arrangements may be made by contacting Treeless Software 
and Design.

Anyone distributing WXPNS for any kind of remuneration must first contact Treeless Software and Design
for authorization. This authorization will be automatically granted to distributors recognized by the (ASP) 
as adhering to its guidelines for shareware distributors, and such distributors may begin offering WXPNS 
immediately (However Treeless Software and Design must still be advised so the distributor can be kept 
up-to-date with the latest version of WXPNS.).

You are encouraged to pass a copy of WXPNS along to your friends for evaluation. Please encourage 
them to register their copy if they find the program useful.



Treeless Software and Design
Treeless Software And Design
82 Whispering Drive
Streamwood,    IL 60107-2302 (USA)

Voice & BBS: 708-372-0825
Fax: 708-372-0059

Internet: TreelessSW@aol.com
CompuServe: 71210,2033
AmericaOnline: TreelessSW

Check out our other programs and utilities on the World Wide Web:

http://members.aol.com/TreelessSW/index.htm



Maintenance Charge To Command
The purpose of these files is to provide accurate record keeping and budgeting information as to how 
much and to whom you spent money on your business trips. If you or your employer do not have the need
for such record keeping or budgeting forecasting, then each file should contain only the default "MISC" 
record and all expenses should reflect "MISC" as both the Charge-To and Vendor.

The procedures for maintenance of the Charge-To and Vendor files are identical. The information 
processed and saved is the same for both files, it's just that the files represent different things to the 
program. The Charge-To file has records containing the names and addresses of the Charge-To types 
(Payment Methods) such as "Cash", "Check", Company Credit Card", etc. While the Vendor file has 
records containing the names and addresses of the Vendors (Who You Paid) that were paid for a specific 
expense such as "American Air Lines", "Mobil Gas", "Holiday Inn", "Glenda's House of Massage", etc.

The fields for the Vendor and Charge To records are just informational and are for your own use. These 
fields, other than the record Key, are not currently used by the WXPNS system.



Expense Report Add Expense Item Command
This command will create an empty line item on the current Expense Report. The values set for this new 
record will duplicate the current date and category but will reset the rest of the fields for this record, so 
you will have to set the Vendor, Charge To and Amount fields.



Expense Report Duplicate Expense Item Command
This command will duplicate the current line item on the current Expense Report. The fields set for this 
new record will duplicate the current Date, Category, Vendor, Charge To, Amount, and information fields.



Expense Report Delete Expense Item Command
This command will delete the current line item on the current Expense Report. There must be a minimum 
of one line item on each Expense Report, so WXPNS will not allow you to delete the last line item.



WXPNS.INI
The following are miscellaneous options that can be turned on/off or modified by the user as he/she feels 
is needed. The file WXPNS.INI can be found in the same directory that contains the WXPNS.EXE 
executable program. The values given below are the defaults for these parameters which should be 
sufficient for most users.

[WXPNS]
ScreenFont=Arial Screen font to use for expense report grid and displays.
ScreenSize=8 Screen font size to use for expense report grid.
PrintFont=Arial Printer font to use for printing formatted expense report and other misc report.
PrintSizeSmall=7 Printer font size to use for compressed text.
PrintSizeBig=12 Printer font size to use for report headers.
ReimburseChar=< Character to use on expense reports and other misc reports to signify a Non-

Reimbursable expense item.
SubCatPrecision=4 Number of decimal points to use for Sub-Category constant value precision.
Enable3d=1 3D appearance for grid and dialogs used in WXPNS (=1 turns 3D on, =0 turns 3D

off).
MaxUsers=5 Maximum number of users allowed to use WXPNS (range is 1 thru 15).
SortItemsBy=1 Field to do initial sort on when Expense Items are loaded. (1=Day, 2=Category, 

3=Vendor, 4=Charge To, 5=Amount)
MaximizeFirst=1 Maximize first Expense Report created or opened (1=yes, 0=no).



Future Enhancements
The following are enhancements to WXPNS that are currently under consideration or are being worked 
on for a future release of the Expense Reporting System.

* Miscellaneous Item Accumulator. The ability to accumulate any type of data such as gallons of gas 
used or miles driven. The details and totals for the items accumulated would be able to be printed on 
the expense report, but would not be included in the expense totals. An offshoot of this would be a 
Mileage Log.

* Foreign Exchange Rate. The ability to enter expenses in one currency and have the Expense 
Report calculate and report the amount in another currency or to have both currencies shown on the 
Expense Report.

* Date Reminder. The ability to display a reminder of important notes that displays the first time you 
run WXPNS for the day. The single line note will start displaying a configurable number of days in 
advance and can be set as a single occurrence, weekly, monthly, or annually.

* Export Expense Report. The ability to export the data for an Expense Report in miscellaneous file 
formats such as delimited text, spreadsheet, and database.

* Expense Report Print Preview. The ability to view a formatted Expense Report on the screen prior 
to printing.

* Static Item Entry Form. Due to the fact that not all fields can be viewed at one time without having to
scroll left or right when using the Expense Report Grid Item Entry, a new static entry form will be 
introduced with version 1.10. The static entry form will display all fields for the currently selected item 
in an entry form at the bottom of the Expense Report window with a list box above it to view or select 
other items in the Expense Report. Initially, the user will be able to select which type of entry to use, 
grid or static form. If we find that users do not use or do not prefer the grid, it will be removed in future
releases.

If you have any ideas or suggestions for WXPNS, please feel free to e-mail the idea to us at:

TreelessSW@aol.com



Registration Form for WXPNS 1.01
Treeless Software and Design
82 Whispering Drive
Streamwood, IL 60107-2302    (USA)

Name:
Address:
City, State, Zip Code:
Telephone:

WXPNS obtained from:

E-Mail address:

REGISTRATION FEE

$ 35.00 Registration fee for this version of WXPNS (1.01)

$  Shipping & Handling to receive the most current version of WXPNS and DOS to Windows
conversion program, $3.50 for North American addresses, $7.00 for all other addresses.

_______

$  Total Included

All of the above amounts are in US Dollars and should be sent in cash, check or money order made 
payable to Treeless Software and Design.



Double Click on a Grid Header and the items within the Expense Report will be resorted by that header 
item.



Edit Cut Command
The Edit|Cut command removes the selected text from your Expense Report edit field and places the text 
in the clipboard.    Choose Edit|Paste to paste the cut text into another Expense Report field. The text 
remains selected in the clipboard, and can be pasted multiple times.



Edit Paste Command
The Edit|Paste command inserts the text currently selected in the clipboard into the current window at the 
cursor position. 



Edit Copy Command
The Edit|Copy command leaves the selected text intact and places an exact copy of it in the clipboard.    
To paste the copied text into another Expense Report edit field, choose Edit|Paste.



Edit Undo Command
The Edit|Undo command restores the edit field in the current Expense Report to the way it was before 
your most recent edit operation.    Undo inserts any characters you deleted, deletes any characters you 
inserted, replaces any characters you overwrote, and moves your cursor back to a prior position.



Edit Menu
The Edit menu provides commands to undo edits, access the clipboard, and to delete text.

Undo Undo the previous operation.
Cut Delete selected text and move it to the clipboard.
Copy Copy selected text to the clipboard.
Paste Move text from the clipboard to the current document.
Delete Delete selected text.



Edit Delete Command
The Edit|Delete command deletes the currently selected text from the current Expense Report edit field.    
The text is not placed in the clipboard.    Use the Edit|Undo command to restore the text.



Copying Text
To copy text to a document from the clipboard, position the cursor at the desired insertion point, and 
choose Edit|Copy from the menu.



Deleting Text
To delete text from a document, select the text, and choose Edit|Cut or Edit|Delete from the menu.    Cut 
will put the deleted text in the clipboard, and Delete will simply delete it.



Maintenance Menu
The Maintenance menu provides commands to modify the Categories/SubCategories, Vendor's, Charge 
To's, Sort Order, User Name/Address information, and to Reconcile Expense Reports.

Categories (F6) Modify Categories and Subcategories
Vendor (F7) Modify Vendor's
Charge To (F8) Modify Charge To's
Report Headers Modify Expense Report Headers
Expense Load Item Sort Order Modify initial Sort order on XR load
User Information (F9) Modify users name/address
Add New User Allow new user to use WXPNS
Reconcile Expense Reports Reconcile XR's with payments



Expense Report Menu
The Expense Report menu provides command to modify aspects of the currently opened Expense Report
File.

Add Expense Item (Ctrl+Ins) Add a blank Expense item
Duplicate Expense Item Duplicate the current Expense line item
Delete Expense Item (Ctrl+Del) Delete the current Expense line item
Print Summary Report Print detailed summary for Expense
XR User Information (F10) Modify your name, address and department
XR Miscellaneous Information (F11) Modify advance amount and reason
XR Daily Information (F12) Modify who and where you went



Expense Report Print Summary Report Command
This command will print a detailed list of all information that exists for this Expense Report.

Each individual line item will be printed along with a summary of expenses for Days, Categories, 
Subcategories, Vendors and Charge To's.



Expense Report User Information Command
The information that is modified here is similar to the master User Information maintenance command 
(your name, address, department and reimbursable flag) except that this information is unique to this 
Expense Report only.



Expense Report Miscellaneous Information Command

This command is used to enter miscellaneous information for this Expense Report.

The information that can be entered is the Cash Advance given to you by your employer, the number of 
days spent on this trip or activity, the percent of the trip that was for personal use (normally zero), and a 
brief explanation of the reason for this trip or activity.

The text entered into the "Reason for Trip" field is free format, meaning you can just keep on typing and 
the text will wrap onto the next line if needed. If you want to force a carriage return in your text, you may 
enter one by typing a Ctrl+Enter key stroke. A maximum of four lines will be printed on the formatted 
Expense Report.



Expense Report Daily Information Command

This is where you enter where you went and who you visited during your business trip. This information is 
printed on the Formatted Expense Report.



Maintenance Reconcile Expense Reports Command

To help you to keep track of what money is still owed you by your employer, you can post any 
reimbursements to the individual Expense Reports.

Enter the total amount of the reimbursement in the "Amount of Payment" field, and then enter the 
amount to apply to each individual Expense Report in the "Apply Now" field. As a number is entered, it 
will be shown in the "Applied" field and subtracted from the "XR Amount" with the result shown in the 
"Remaining" field.



Maintenance Report Headers Command
The titles used on the formatted Expense Report can be modified through this command.

Use the "Reset" option to set all of the fields to their default values.



Maintenance User Information Command

This is where the user enters their name, address, department and itemize reimbursables. This 
information is printed on the formatted Expense Report.

The "Itemize Non Reimbursable" code is used to tell WXPNS if and where you want any non-
reimbursable expense item to be printed on the Expense Report. This code overrides any itemization 
code for a specific Category or Sub Category.

There are two versions of User Information, a master copy and an Expense Report copy. The master 
information is used as the default information when the user creates a new Expense Report. When you 
modify the master User Information, each Expense Report's User Information is not changed, and when 
you change the User Information for an Expense Report, the master User Information is not changed.



Maintenance Expense Load Item Sort Order Command
When an existing Expense Report is first loaded, WXPNS will sort the records before they are displayed 
on the screen.

The valid initial sort order fields are; 1) Day, 2) Category, 3) Vendor, 4)Charge To and 5) Amount.

You can also resort a loaded Expense Report by Double-Clicking on one of the grid title fields.



Maintenance Add New User Command
More than one user can use the WXPNS system on a single computer or network. Currently, the 
maximum number of users that can be added to WXPNS is 15. Each users data files are kept in individual
disk directories.

You will first be asked to enter a Key to identify yourself. This would normally be your initials or something 
else to uniquely identify yourself. This Key is used as the directory name used to store this users data 
files. If the disk directory does not exist, WXPNS will attempt to create it.

If the User Key is accepted and the directory is valid, a blank User Information screen is displayed for you
to enter your Name and Address. After entering your Name and Address, click on "OK" and you will be 
allowed to create New Expense Reports.

To change from one valid user to another, click on the File menu option and then click on any of the listed 
User Names.



File Print Blank Expense Report Command
The File|Print Blank Expense Report command prints a formatted Expense Report without 
any data. The program assumes the report will be printed in landscape mode (sideways) and
will attempt to change the mode if the printer is set in portrait mode. A Print Options dialog 
box will be displayed that allows you to change the output printer device, print quality, 
copies, and other printer options.



Expense Report Fields
Each individual Expense Report line item retains the following information and data fields;

* Day of the week,
* Category or Sub Category,
* Vendor,
* Charge To,
* Amount; for a Sub Category line item, this is the number to multiply by the Sub Category constant. 

The result is the actual expense amount for this item. Using "Mileage" as an example, you would 
enter the number of miles you drove in the Amount field and WXPNS would automatically multiply the 
number entered by the mileage constant in the "Mileage" Sub Category record to arrive at the actual 
expense amount for this item. The calculated amount is displayed in the Description field,

* Description of expense or Name of Persons Entertained; this is a non essential field and can contain 
anything you want to enter,

* Time and Place; this is a non essential field and can contain anything you want to enter,
* Nature or Purpose of Item; this is a non essential field and can contain anything you want to enter,
* Percent Allocated to Business, normally 100%,
* and whether the expense is reimbursable or not. A non-reimbursable expense item will not be used in 

calculations determining the amount your employer needs to reimburse to you.



Version 1.01
* MaximizeFirst option in wxpns.ini configuration file. If this option is set to "1", then the first expense 

report created or opened will be maximized within the WXPNS main window frame. If the option is set
to "0", then the first expense report opened or created will be displayed in NORMAL mode (a child 
window within the WXPNS main window frame). The default mode is "1".

* Increased the internal stack size from 12K to 16K to overcome stack overflow errors.

* Add item or Duplicate item now will display the new item below the current item.

* Check if "CTL3D32.DLL" or "CTL3DV2.DLL" common routines exist before enabling 3D mode.

* "Add Expense Item" command had a problem when one of the combo boxes was selected (Vendor, 
Charge To) when a new line was added. The previous lines' contents of the selected combo box was 
still selected on the new blank line and could have been entered as valid data if the user did not 
immediately tab away from that field. Now all combo boxes selected indexes are reset, so the proper 
element will be reselected (ie "n/a") for the fields on the new line.






